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Copyright 

Copyright © 2005 HighPoint Technologies, Inc.  This document contains materials protected by 
International Copyright Laws. All rights reserved.  No part of this manual may be reproduced, transmitted 
or transcribed in any form and for any purpose without the express written permission of HighPoint 
Technologies, Inc. 

 

Trademarks 

Companies and products mentioned in this manual are for identification purpose only.  Product names or 
brand names appearing in this manual may or may not be registered trademarks or copyrights of their 
respective owners.  Backup your important data before using HighPoint's products and use at your own risk.  
In no event shall HighPoint be liable for any loss of profits, or for direct, indirect, special, incidental or 
consequential damages arising from any defect or error in HighPoint's products or manuals.  Information in 
this manual is subject to change without notice and does not represent a commitment on the part of 
HighPoint. 

 

Notice 

Reasonable effort has been made to ensure that the information in this manual is accurate.  HighPoint 
assumes no liability for technical inaccuracies, typographical, or other errors  contained herein. 
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About this Guide 
The RocketRAID 2220 SATA II Host Adapter’s User’s Guide provides  information about the functions and 
capabilities of the host adapter, and instructions for installing, configuring and maintaining RAID arrays 
hosted by the adapter.   

 

Introducing the RocketRAID 2220 Host Adapter 
The HighPoint RocketRAID 2220 is an 8-channel Serial ATA  II RAID controller.  It utilizes a 64bit, 
133MHz PCI-X interface.  The RocketRAID 2220 solution is aimed at enterprise storage applications, 
NAS storage, workgroup and web servers, video streaming / video editing workstations, back up, and 
security systems. 

Product Features 

� 8 Channels PCI-X to SATAII host adapter 

� Supports up to 8 SATA/SATAII hard disk drives  

� PCI-X 64-bit, 66/100/133MHz PCI bus 

� 64-bit LBA support for drive capacity over 2TB 

� Supports RAID 0, 1, 5, 10, and JBOD 

� Single RAID cross-adapter (up to 16 disks per array) 

� Supports Native Command Queuing (NCQ) 

� Online Capacity Expansion (OCE) 

� Online RAID Level Migration (ORLM) 

� Staggered drive spin-up support  

� S.M.A.R.T. monitoring of hard disk status for reliability 

� SAF-TE Enclosure management 

� Hot Swap and Hot Spare support  

� Audible alarm 

� LED support (disk activity and disk failure status) 

� Quick and Background initialization for quick RAID configuration 

� BIOS boot support  

� Command Line Interface for RAID management (CLI) 

� Graphical RAID Management Software (RAID Management Console) 

� Automatic RAID rebuild  

� SMTP support for email notification 

� Windows 2000, XP, Server 2003, Linux and FreeBSD support  
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Understanding RAID Concepts and Terminology 
The following concepts and terminology is commonly used when describing the functions of the 
RocketRAID 2220 Host Adapter. 

 

Disk initialization 

Initializing a disk writes necessary RAID configuration information to that disk.  Disks must be initialized 
before configuring them into RAID arrays.  The initialization process will destroy all data on the disk. 

 

Disk Status  

New   The disk contains no data and has not been initialized. 

Initialized  The disk has been initialized and can be used for array creation. 

Configured  The disk has been assigned to one or more arrays, or configured as a spare disk. 

Legacy  The disk was used on other controllers before use with the RocketRAID 2220 (see legacy 
disk below). 

 

Array initialization 

A redundant array (RAID5, RAID1, RAID10) needs to be initialized to ensure full performance and 
reliability.  Non-redundant arrays (RAID0, JBOD) do not need to be initialized. 

When you create a redundant array using the RocketRAID 2220 controller’s BIOS Configuration Utility, it 
will create the array in un-initialized state.  The initialization process can be completed after installing the 
driver and management software. 

When creating an array using the HighPoint RAID Management Console software, you can specify an 
initialization option (Skip initialization, foreground and background). 

 

Foreground initialization 

Foreground initialization will zero-out all data on the array. The array is not accessible by the operating 
system until initialization is complete. 

 

Background initialization 

Background initialization allows the array to be used immediately.  For RAID1 and RAID10 arrays, 
initialization will results in data being duplicated identically to the mirror pair.  For RAID5 arrays, 
initialization will result in parity being generated from all array members. 

Note: An un-initialized RAID1 or RAID10 array can still provide redundancy in case of a disk failure. A 
RAID5 array, however, is not fault-tolerant until initialization is finished. 
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Online Capacity Expansion (OCE)   
 
This feature allows disks to be added to exis ting RAID arrays, in order to increase the array’s capacity, 
without fear of data loss.  Any number of disks can be added to an array, at any time.  Data can be accessed 
and utilized even while being redistributed. 
 
Online RAID Level Migration  
This term describes the ability to change one type of array (RAID level), into a different type of array 
(changing a RAID 1 array into a RAID 10 array for example).  Data is still accessible during the migration 
process, and a base level of security is still active. 
 
OCE, OLRM and the RocketRAID 2220 
The RocketRAID 2220  supports both Online Capacity Expansion (OCE), and Online RAID Level 
Migration (ORLM).  Both features are supported by a single function - an array can be transformed from 
one RAID level to another RAID level while simultaneously being resized, even under I/O load.  
 
Spare disk 

A spare disk is a single disk that can be used to automatically rebuild a redundant array in case of drive 
failure.  Spare disks may also be members of a RAID array.  Any available space on these disks may be 
used to rebuild other broken arrays. 

 
Legacy disk 

Disks attached to the RocketRAID 2220 that contain valid partition tables will be identified as legacy disks .  
A legacy disk attached to the RocketRAID 2220 can be accessed by the operating system, but cannot  be 
used to create RAID arrays.  A legacy disk must be initialized before assigning it to an array. 
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RocketRAID 2220 Hardware 

Description/Installation 
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RocketRAID 2220 Hardware 
 
1 – RocketRAID 2220 Adapter Layout 
 

 
 

Port1- Port8   
These represent the RocketRAID 2220’s eight SATA channels.  The SATA port furthest away from the 
surface of the adapter is always the odd numbered channel (1, 3, 5, 7), while the port closest to the adapter 
is the even numbered channel (2, 4, 6, 8). 
 
CON1 - CON3 
LED connectors (disk-activity/disk-failure):  The RocketRAID 2220 does not utilize CON1.  CON2 is for 
use with hard disk activity LED’s, while CON3 provides disk failure LED support.  LED support is 
discussed in greater detail in the LED Connection section (page 10), and in a separate document, the 
RocketRAID 2220 LED guide (which discusses LED installation for specific server chassis, and will be 
available in downloadable form from our website). 
 
JP1 and JP2  
These jumpers enable cross-adapter RAID support.  The RocketRAID 2220 includes a cable designed for 
use with these jumpers.  Consult the Single-RAID Cross Adapter section (page 13) for more information. 
 
Speaker 
Alarm (speaker):  the speaker emits and audible alarm in the case of disk/array failure. 
 
JP5 
I²C jumper/SAF-TE support:  this support is dependent upon the system chassis.  Not all chassis models 
support SAF-TE features.  Consult the chassis’s manual for more information. 
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2 - LED Connections 
 
D1 through D8 represent SATA channels SATA1 through SATA8 respectively. The following diagrams 
describe the connector pin definitions for LED CON2 (disk activity), and CON3 (disk failure).  CON1is not 
utilized by the RocketRAID 2220. 

CON2: Hard Disk Activity (D1 through D8) 
 

 
 
CON3: Hard Disk Failure (D1 through D8) 
 

 
RocketRAID 2220 LED Guide 
For more information about LED support, and installation guides for various chassis configurations, consult 
the RocketRAID 2220 LED Guide. 
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3 - Installing the RocketRAID 2220 Host Adapter 
 
Note: Make sure the system is powered-off before installing the RocketRAID 2220 host adapter. 
The RocketRAID 2220  includes both standard and low-profile brackets.  It may be necessary to attach the 
low-profile bracket in place of the standard bracket, depending upon the chassis design. 
 
1. Open the system chassis and locate an unused PCI-X slot.   
 
2. Remove the PCI slot cover. 
 
3. Gently insert the RocketRAID 2220 into the PCI slot, and secure the bracket to the system chassis. 
 

 
 
 
4. After installing the adapter, attach hard disks to the RocketRAID 2220 using an SATA data cable.  

SATA cables have universal connections – either end can be attached to the adapter or hard disk.  
Each RocketRAID 2220  included eight SATA cables, and supports up to eight separate hard disks 
drives.   

 
5. Many server-level chassis include hard-disk hot-swap bays.  For these system chassis, cables are 

attached to the chassis backplane, rather than directly to each individual hard disk.  Consult the 
chassis’s manual for proper installation procedures. 

 
6. Close and secure the system chassis. 
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4 - Verifying Installation 
 
Once the Rocket RAID 2220 host adapter and hard disks have been installed into the chassis, boot-up the 
system to verify that the hardware is properly recognized. 
 
1. Power on the system.  If the system detects the presence of the adapter, the RocketRAID 2220 BIOS 

will be displayed. 
 
2. Press Ctrl+H to access the RocketRAID 2220 BIOS Utility. 
 
The BIOS Utility will display information about hard disks attached to the adapter. Make sure all attached 
disks are detected by this utility.  If any of the hard disks are not detected, power down the system and 
check the power and SATA cable connections. 
 
 

5 - Single-RAID Cross Adapter 
 
The RocketRAID 2220  is capable of supporting RAID arrays created between hard disks attached to 
multiple host adapters.  Up to sixteen hard disks can be assigned to a single RAID array, and these disks 
can be attached to as many as four separate RocketRAID 2220 host adapters.  This feature is referred to as 
“Single-RAID Cross Adapter” support.   
 
Each RocketRAID 2220 provides two jumpers dedicated to this feature (JP1 and JP2), and a single cross-
adapter cable designed for use with these jumpers.  JP1 is a 3-pin jumper, while JP2 is a 4-pin design. 
Each cross-adapter cable has a 3-pin and 4-pin connector, designed for insertion into JP1 and JP2 
respectively.  
 
Example installation: 
For a 16-hard disk, 2-card cross-adapter RAID configuration, install a second card into the next available 
PCI-X slot.  Insert one end of the cross-adapter cable into the appropriate jumper on the first adapter (3-pin 
connector to JP1, 4-pin connector to JP2), and the remaining connector into the appropriate jumper on the 
second adapter.  There is no particular connector-to-jumper requirement.  Any given connector can be 
inserted into the corresponding jumper on either card. 
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RocketRAID 2220 BIOS Utility 
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RocketRAID 2220 BIOS Utility 
 
The RocketRAID 2220 's BIOS Utility can be accessed using the " Ctrl+H" command. 
This command should be displayed automatically when the RocketRAID 2220's BIOS screen appears 
during the system's boot up procedure. 
 
1 - BIOS Command Overview 
 
The RocketRAID 2220  BIOS Utility provides a wide selection of RAID related commands.  These 
commands are displayed towards the top of the utility's interface. 
 

 
 
Use the ← →arrow keys to scroll through the various commands, and the ↑ ↓  arrows to browse through the 
corresponding command menus.   Use the ENTER key to execute the selected command. 
The ESC button can be used to cancel the selected command, or return to the previous command menu. 
 
Create  - this command is used to create RAID arrays.   Section x - 2 discusses this command in detail. 
 
Delete  - this command will delete the selected RAID array. 
 
Warning:  This command may result in permanent data loss - it should only be used if data stored on the 
target array is no longer relevant, or has been backed up to an alternate storage device. 
 
 
Add/Remove Spare - this command is used to assign hard disks to function as spare disks.  The 
controller is capable of using spare disks to automatically rebuild broken or faulted RAID arrays.   
Section x - 3 discusses this command in detail.  
 
Settings 
 
Set Boot Mark  - this function is used to designate a particular disk or RAID array to function as the 
RocketRAID 2220's boot device. 
 
Note:  This setting is only relevant if the motherboard's BIOS has set the RocketRAID 2220 to function as 
the system’s primary boot device. 
 
Staggered spin up – This function is used to enable (or disable) staggered drive spin up support.  
Staggered drive spin up, by default, is disabled.  When enabled, the RocketRAID 2220 will power up the 
hard disks one at a time, approximately every two seconds. 
View – this command is used to select between two views. Press the ENTER key to change the view. 
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Devices  – displays information about hard disks attached to the RocketRAID 2220.  Use the ↑ ↓  arrow 
keys to highlight the target hard disk, and press ENTER to view the information. 
RAID arrays – displays information about RAID arrays attached to the RocketRAID 2220.  Use the ↑  ↓  
arrow keys to highlight the target array, and press ENTER to view the information. 
 
 
Initialize  - this function is used to prepare disks for use with RAID arrays.   
 
Note:  Arrays cannot be created between disks that have not been initialized. 
Section x - 2 discusses this command in detail. 
 
 
2 - Creating RAID Arrays 
 
Initializing Disks: 
 
Before creating a RAID array, the disks must be initialized. 
Initialization writes necessary RAID configuration information to the hard disk.  
Use the ← →arrow keys to select the Initialize command, and press ENTER. 
 
Warning: Initialization will destroy all pre- existing data on the selected hard disks. 
 
Use the ↑ ↓  arrow keys to highlight the target hard disk(s) and press ENTER.  Next, press the Y (yes) key 
to initialize the selected disk(s), or N (no) key to cancel the initialization process. 
 
Once initialized, these disks can be utilized to create RAID arrays. 
 
To create an array: 
 
1. Use the ← →  arrow keys to highlight the Create  command, and press ENTER to open the Create 

Menu. 
 
2. Use the ↑  ↓ arrow keys to select the appropriate RAID level, then press ENTER. 
 
3. Next, use the ↓  arrow key to highlight the Array Name  option and press ENTER.  The array name 

dialogue box will appear.  Use the keyboard to input a new Array Name, and press the Enter key. 
 

Note: the Array Name command is optional – it is not necessary to name the array.  The array can be 
named at a later time, and the name of the array can be changed at any time. 

 
4. On the Create menu, use the ↓  arrow key to highlight the Select Devices  item and press ENTER. A 

device list will appear, and display all available hard disk drives. 
 
5. Highlight the target disks that you want to use, and press ENTER to select them. After all of the disks 

have been selected, press the ESC key to return to the Create Menu. 
 
6. Next, Use the ↓  arrow key to highlight the Capacity (GB) option and press ENTER.  The total 

available capacity will be displayed.  Press ENTER if you wish to use all available space.  
 
7. If you wish to reserve disk space for additional arrays/single disks, use the keyboard to input the 

amount of space (in GB) you wish to set aside for this particular array, and press ENTER.   
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Note:  Multiple arrays can be created using the same set of hard disk drives.  The Capacity option 
allows you to set aside disk space that be used to create another array or set as a spare disk. 

 
8. To complete the creation procedure, use the ↓  arrow key to highlight the Start Creation item and 

press ENTER. 
 
Single RAID – Cross Adapter 
 
The term “Single RAID – Cross Adapter” refers to the RocketRAID 2220 ability to create RAID arrays 
between drives attached to multiple RocketRAID 2220 Adapters.  Each RAID array can support up to 16 
hard disks, and these disks can be attached to as many as 4 separate RocketRAID 2220 adapters.   
Cross-Adapter arrays are created in the same manner as standard arrays.  The BIOS utility menu will 
display disks attached to each RocketRAID 2220 adapter installed into the system.  Use the Page Up and 
Page Down keys to scroll through available hard disks. 
 
 
3 - Adding/Removing Spare Disks 
 
This command is used to assign a hard disk to act as a Spare Disk. 
Spare Disks are used to automatically rebuild Redundant RAID arrays (RAID 1, 5, 10) in the case of disk 
failure.  To set a hard disk to act as a Spare Disk, use the ↑  ↓  arrow keys to select a disk, and press ENTER. 
To remove the Spare Disk setting from a hard disk, highlight the spare disk, and press ENTER. 
 
Generally, single disks are designated to act as spares (disks that are not configured into RAID arrays). 
However, in some instances, disks that are members of RAID arrays may also be designated to act as a 
spare.   If the disks in question are part of a RAID array that did not utilize the full available capacity at the 
time of creation, these disks may be used as spares.   
For example: a RAID 0 array was created between two 200GB hard disks, but only 200GB of space (out of 
a grand total of 400GB), was assigned to that array.   In this example, 200GB of disk space remains 
unallocated.   This unallocated space would allow these disks to be set as spares for a separate redundant 
array that falls into the same capacity range (200GB). 
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RocketRAID 2220 Driver and Software 
Installation Microsoft Windows (2000, XP, 2003 

Server) 
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Windows Driver Installation 
 
Before installing the RocketRAID 2220 device driver, make sure the Rocket RAID 2220 host adapter and 
all required hard disks have been installed into the system’s chassis (refer to the Hardware Installation 
section, page 12). 
 
 
Installing the RocketRAID 2220 driver for an existing Windows XP/2003 system  
 
After the operating system has booted, Windows XP/2003 will automatically detect the RocketRAID 2220, 
and request that a device driver be installed.   To install the device driver, follow the steps outlined below: 
 
1. When the "Found New Hardware Wizard" window appears, select "Install from a list or specific 

location (Advanced)", and click Next to continue.  
 
2. Click on the "Include this location in the search" option, and select the system's floppy drive (generally 

Disk A).  Next, insert the Driver Installation diskette into the system's floppy drive. 
 
3. At the Hardware Wizard screen, select the floppy drive as the source, then click the Next button.  

Select the Win2003 folder, then click the Next button. 
 
4. Windows will display a warning message that states the driver has "not been signed".  Select 

"Continue Anyway", then click Finish when pro mpted. 
 
5. Remove the Driver Installation diskette from the floppy drive, then Shut down and restart the computer. 
 
Installation Verification 
 
After the driver has been installed, and the system has been restarted: 
 
1. Click the Start button, then right-click My Computer icon.  Select the Properties item from the popup 

menu.  
 
2. In the popup window, select Hardware tab and then click Device Manager button.  
 
3. Double click the “SCSI and RAID controllers” entry.  If the RocketRAID 2220  device entry is not 

displayed, o r there are "?" or "!" marks displayed near the RocketRAID 2220 entry, the driver has not 
been installed properly. Delete the entries and reinstall the driver.  
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Installing the RocketRAID 2220 driver during a fresh Windows 2000/XP/2003 
installation 
 
1. After booting from the Windows 2000/XP/2003 CD-ROM, when the Windows XP Setup blue screen 

appears, look towards the bottom of the screen.  Windows will prompt you to press the F6 key if you 
want to install a third part SCSI or RAID driver.  Press the F6 key at this time.  

 
2. The setup procedure will continue, and will later instruct you to press the "S" key to specify additional 

adapters. Press the "S" key as instructed. 
 
3. Next, the setup program will prompt for the insertion of the driver diskette.  Please insert the driver 

diskette, and then press ENTER to continue.  
 
4. The next window will display several driver options.  Please select the RocketRAID 2220 Controller 

for the corresponding operating system, and press ENTER to continue.  
 
 

1 - Installing the RAID Management Console/ Interface Overview 
 
To install the RAID software, locate the setup.exe file located on the floppy diskette labeled "DISK 1" (or 
the Disk1 folder, if the software was downloaded). 
Double click this file to start the Installation Wizard. 
 
There is no need to restart the system after installing the software. 
To start the software, double -click the (picture) icon on the desktop. 
 
 
Logging On 
 
The RAID Management Console requires that a user (or Administrator) log on. 
The software is incapable of working with RAID arrays or hard disks attached to the RocketRAID 2220 
until the user has logged on. 
 

 
 
Default Parameters: 
System Address:  127.0.0.1 
Port: 7402 
User Name: RAID 
Password: hpt 
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Logging On (continued) 
 
Note: The password and user name fields are case sensitive. 
 
The first time the software is used, make sure to enter the information listed above. 
After successfully logging on, the software will ask you to alter the password (as a security precaution). 
Enter a password, and press enter.  
 
 
2 - Software Interface - Overview of commands/functions 
 
After logging on, several new options will become available. 
These commands are displayed towards the top of the interface window: 
 

 
 
Overview of Function-menus (tabs) 
 
File 
 
Remote Control  - view information about remote systems  
System Configuration - switch between available remote systems  
User Management - Add or remove users, edit user profiles  
Password - change the password 
Exit - exit the utility interface 
 
 
Management 
 
RAID Management  – Create/delete/maintain RAID arrays 
Device Management - check information or change settings for host adapters, and hard disks 
Spare management - create and assign spare disks 
System Notification - Set up system notification options 
 
 
View 
 
Event view - Views the event log 
Icon view - view icon descriptions (legend) 
 
Operation 
 
This menu will list all available commands for the selected Function menu. 
These commands are also represented in icon/button form (below the function-menu/tabs selections) 
 
Help 
 
Search through help topics related to the RAID Management Console software 
View software version information 
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3 - Creating an Array 
 
To create an array: 
 
1. Highlight the “Management” menu, then select the "Array Management” function. 
 
2. Click the Create button on the toolbar or select the "Create" command from the "Operation" menu.  

The array creation wizard will appear. 
 

 
 
3. Select the desired RAID level from the drop-down list. 
 
4. Enter a name for the array using the keyboard (this is optional), and click the Next button. 
 
5. If you are creating a redundant array (RAID 1, 5, 10), select an initialization option.  If you are 

creating a RAID 0 or JBOD (volume), skip to step 6: 
 

For RAID1 and RAID 10 arrays, the default initialization method is "No initialization".  
 

For RAID5 a rrays, the default initialization method is "Foreground". 
 

If you are creating RAID5, you will be asked to specify a cache policy: 
 

Write -back - when the write-back setting is selected, all write requests sent to the array are cached. 
This will result in higher performance, but data loss may occur in case of a power failure. 

 
Write -through - when the write-through setting is selected, all write requests sent to the array are 
passed directly to the disks. However, subsequent reads may still be completed from the cache if 
appropriate. 

 
6. Select which disks are to be used to create the array.  Highlight the desired disk from the left -side 

of the interface (available disks), then click on the  button to move the disk to the right side of 
the interface (selected disks).  Disks must be selected one a time.   
If you wish to remove a selected disk, highlight it from the selected disk section, and use the  
button to move it to the available disk section. 
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Note:  The selection sequence is important - the order in which the disks are selected will determine 
the disk sequence of the array. 
 

7. Select the capacity  - the RocketRAID 2220 can create multiple arrays on the same set of drives.   As a 
result of this feature, you have the option of assigning a physical disk to multiple RAID arrays.   

 
Press Enter to use the default value (the maximum capacity for the array), or specify the desired value 
using the keyboard, and press Enter to confirm this selection.  Then, click the Finish button. 

 
Note: If you have specified an initialization option, the initialization process will start automatically.  A 
progress bar will be displayed towards the bottom of the interface window, and will indicate % completion, 
and provide an estimate of the time needed to complete the initialization procedure. 
 
 
Single RAID – Cross Adapter 
 
The term “Single RAID – Cross Adapter” refers to the RocketRAID 2220 ability to create RAID arrays 
between drives attached to multiple RocketRAID 2220 Adapters.  Each RAID array can support up to 16 
hard disks, and these disks can be attached to as many as 4 separate RocketRAID 2220 adapters.   
Cross-Adapter arrays are created in the same manner as standard arrays.  The Creation menu will display 
disks attached to each RocketRAID 2220  adapter installed into the system. 
 
 
4 - Deleting an Array 
 
To delete an array: 
 
1. Highlight the “Management" menu, then select the "Array Management” function. 
 
2. Highlight the array you want to delete, then click on the "Delete Icon" or select the Delete command 
from the "Operation" menu. 
 
3. A warning message will appear. Click Yes to delete the array.  Click No to stop this procedure. 
  
Note: An array in use by the operating system cannot be deleted. Any data stored on a deleted array will be 
inaccessible   
 
 
5 - Configuring Spare Disks 
 
Spare disks can be used to rebuild redundant RAID arrays in the case of failure. 
To configure spare disks, highlight the "Management" menu, and select the "Spare Management” function. 
The Spare Management window will appear. 
  
To add a spare disk, select it from the Available Disk list box and click the  button to add the disk to 
the Spare Pool list box. 
To remove a spare disk, select it from the Spare Pool list box and click the  button to remove the disk 
from the Spare Pool list box.  
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6 - Recovering/Verifying Arrays 
 
When an array member (hard disk) of a redundant array fails, the array will be marked as "broken".   
Broken arrays can be automatically rebuilt using hot-spare disks (see page 23). 
However, if there are no available spare disks, you can still rebuild the array by adding a new disk to it. To 
add a disk to a broken array: 
 
1. Highlight the “Management" menu, and select the "Array Management” function. 
2. Highlight the broken array that needs to be rebuilt. 
3. Click the Add Disk button on the too lbar or select "Add Disk" command from the “Operation" menu. 
4. If the disk is successfully added to the array, rebuild process will start automatically.  
 
Note: In some instances, a failed array will not rebuild automatically. 
 
To manually start the rebuild process for a broken/critical array: 
 
1. Highlight the “Management" menu, and select the "Array Management” function. 
2. Highlight the array that needs to be rebuilt. 
3. Click the Rebuild button on the toolbar or select the "Rebuild” command from the "Operation" menu. 
 
Verifying an Array 
 
For a RAID 1 or RAID 10 array, the verify process compares the data of one mirror pair with the other 
(single hard disk in the case of RAID1, and a paired set of disks for RAID 10). 
For RAID 5, the verify process calculates RAID5 parity and compares it to the parity data on the array. 
Verification checks each sector on a given disk.  Periodic verification of an array allows the disk drive 
firmware to take corrective actions on problem areas on the disk, minimizing the occurrence of 
uncorrectable read and write errors. 
 
To verify an array: 
1. Highlight the “Management" menu, and select the "Array Management” function. 
2. Highlight the array you want to verify. 
3. Click the Verify button on the toolbar or select the "Verify" command from the "Operation" menu. 
4. Verify process will start. 
 
 

7 – OCE/ORLM 
 
The RocketRAID 2220  supports both OCE (Online Capacity Expansion), and ORLM (Online RAID Level 
Migration. 
The RAID software provides support for these features through a single function, known as OCE/OLRM. 
 
With the OCE/ORLM function, you can transform an array from one RAID level to another RAID level 
and/or resize the array dynamically, even under I/O load.  
 
To perform OCE/ORLM on an array: 
 
1. Highlight the "Management" menu, and select the "Array Management” function. 
2. Highlight the array you want to alter. 

3. Click the  button on the toolbar or select "OCE/OLRM" command from the "Operation" menu. 
To perform OCE/ORLM on an array (continued) 
 
4. The OCE/ORLM window will appear.  
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5. The interface is very similar to the Array Creation Wizard interface.  Select the type of array you wish 
to change the existing array into, then set any corresponding parameters (cache options, capacity, if 
relevant). 

 
Notes: 

1. When expanding a JBOD array, all the original disks must be included in the target array, and 
these disks must be selected in the same order (as the original array).  If you want to migrate a 
JBOD array to another RAID level, only the first member disk can be included in the target array.  
For examp le, a JBOD comprised of 3 disks (1, 2, 3), can only be “migrated” using disk 1.  Disks 2 
and 3 cannot be used – disk 1 would have to be combined with other disks attached to the 
RocketRAID 2220 (4, 5, 6, 7, 8). 

2. You cannot change an array to another type of array with a smaller capacity.  In some cases, a disk 
may need to be added to the RocketRAID 2220. 

3. During the OCE/ORLM procedure, the redundancy level of the array will be the lowest of the 
source and target arrays; e.g. if you ORLM a RAID0 array to a RAID1 array, the array will be 
non-redundant until the procedure is complete. 

4. The OCE/ORLM process can be aborted and continued at later time. However, you should always 
stop the transform progress from the RAID Management software.  

5. An unexpected system crash may result in data loss while performing OCE/ORLM on an array. 
We strongly recommend backing up data before starting the OCE/ORLM process. 

 
 

8 - Misc. Array/Device Options 
 
Device Management 
 
The Device Management window provides configuration information about controllers (the RocketRAID 
2220 and other HighPoint host adapters), channels and hard disks.  
To access the Device Management window, highlight the "Management" menu, and select the "Device 
Management" function. 
 
Changing Device Settings 
 
Depending upon the hard disk in question, and support provided by the current device driver, you can 
adjust settings for disk: Read Ahead, Write Cache, TCQ, and NCQ.   Each feature can be enabled or 
disabled individually. 
 
S.M.A.R.T Status 
 
You can view S.M.A.R.T. (Self-Monitoring, Analysis, and Reporting Technology) data about a drive to 
help troubleshoot any problems that occur. You can also setup periodical S.M.A.R.T. status checks that 
send notification messages when S.M.A.R.T. thresholds are exceeded. 
 
To view the S.M.A.R.T status of a hard disk: 
 
1. Highlight the “Management” menu, and select the “ Device Management” function. 
2. Highlight the disk you want to examine. 

3. Select the “SMART” command from the “Operation” menu, or click on the  button to display the 
S.M.A.R.T status/settings window. 
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Renaming an Array 
 
1. Highlight the "Management" menu, and select the "Array Management” function. 
2. Highlight the array you want to rename. 
3. Click the Rename button on the toolbar or select the "Rename" command from the "Operation" menu. 
4. Enter a new name for the array using the keyboard, and press the OK button to confirm your selection. 
Note: An array running background tasks cannot be renamed. 
 
 

9 - Managing Events 
 
The HighPoint RAID Management Console will log all events that have occurred on any host adapter 
under its control.   
 
Viewing Logged Events 
 
To view logged events: 
 
1. Highlight the “View” menu, and select the “Event View” option. 
2. In the Event View window, you can filer events, clear events, and save events to a file. 
 
Configuring E-mail notification 
 
To enable E-mail notification: 
 
1. Highlight the “Management” menu, and select the “Event Notification” function. 
2. Click the Setting button on the toolbar or select “Setting” option from the “Operation” menu. 
3. Next, enter the necessary information in the E-mail Notification Setting window. 
  

 
 
Note: The current software does not support SMTP servers that require user authentication. 
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To add a Recipient: 
 
1. Highlight the “Management” menu, and select the “Event Notification” function. 
2. Click the “Add” button on the toolbar or select “Add” command from the “Operation” menu. 
3. Enter the necessary information in the Add recipient window. 

 

 
 
4. The recipient will be listed in the main window. You can use Modify or Delete button on the toolbar to 

modify or delete the recipient. 
 
To test E-mail notification: 
 
1. Highlight the “Management” menu, and select the “Event Notification” function. 
2. Select one recipient from the main window. 
3. Click the Test button on the toolbar or select the “Test” command from the “Operation” menu. 
4. The software will send a “test” e-mail message to the selected recipient. 
 
 
Managing Tasks 
 
The RAID management Console can be used to setup routine, periodical background-rebuild or verify tasks 
that will help maintain the integrity of RAID arrays attached to the RocketRAID 2220. 
 
To setup and schedule tasks highlight the “Management” menu, and select the “Task Management” 
function to open Task Management window. 
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Task Management (continued) 
 

 
 
The Task Schedule list displays all of the tasks assigned to the selected remote system.  To view detailed 
information about a specific task, highlight and Double-click the task’s name. 
 
Add a Scheduled Task 
 
This command is used to add a Scheduled task for the selected remote system.  To add a new scheduled 
task: 
 

Click the “New” button on the toolbar.  The new task schedule wizard will appear. 
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New Task Wizard (continued 
 

 
 

Select the task type and the array that you want to verify or rebuild, then click “Next”.  
 

 
 
1. Enter a name for the task. 
2. Configure the frequency for the task. 
3. Set the duration for the task. 
4. Check the “Enable the task” option to activate this task. 
5. Click “Finish”.  



 

 29 

Modify a Scheduled Task 
 
This command is used to change settings for a scheduled task.  To Modify a Task Schedule: 
 
1. Select a task from the Task schedule list. 
2. Click the “Modify” button on the toolbar, and modify the task settings in the popup window. 
 
Delete a Scheduled Task 
 
This command is used to delete a Scheduled Task for the selected remote system.  To delete a Task 
Schedule: 
 
1. Select a task from the Task schedule list. 
2. Click the “Delete” button on the toolbar. 
 

 
10 - Configuring Remote Systems 
 
Then HighPoint RAID Management Console manages a RAID controller through a connection to the 
HighPoint RAID Management Service, which runs on the system where the RAID host adapter is 
physically installed.  This type of system is referred to as a “remote system”.   
 
Note: What the software classifies as a “remote system” may not always be an actual remote computer.   In 
some configurations, the local computer hosts both the RAID host adapter and Management Service.  The 
local system, in these cases, is still generically referred to as a “remote system”.  
 
Add a Connection 
 
This command is used to add new connection to a remote system.  To Add a Connection: 
 
1. Highlight the “File” menu, and select the “Remote Control” function. 
2. Click the Add button on the toolbar or select the “Add” command from the “Operation” menu.  
3. Enter the system address, name, and port information in the popup window. 
 

 
  
The system address can be a host name, or an IP address.  The default system port is 7402. 
 
4. Click “OK” to finish adding the new connection. 
 



 

 30 

Modify a Connection 
 
This command modifies connection information for a remote system.  To modify a connection: 
 
1. Highlight the “File” menu and select the “Remote Control” function. 
2. Highlight the system you want to modify. 
3. Click the Modify button on the toolbar or select the “Modify” command from the “Operation” menu. 
 

 
 
4. Enter new connection information in the popup window, and click OK to apply the changes. 
 
Note: The System Address cannot be modified.  If you insist on modifying this item, you must first delete 
this connection and then add a new connection.  In addition, the connected system cannot be modified – 
you must first disconnect from this system. 
 
 
Delete a Connection 
 
This command deletes a remote system from the connection list.  To delete a connection: 
 
1. Highlight the “File” menu and select the “Remote Control” function. 
2. Highlight the system you want to delete. 
3. Click the “Delete” button on the toolbar or select the “Delete” command from the “Operation” menu. 
4. A warning message will be displayed.  Click “Yes” to delete the item.  Select No to cancel this command. 
 
Connect to a Remote System 
 
This command establishes a connection to a remote system for RAID management. To connect to a remote 
system: 
 
1. Highlight the “File” menu and select the “Remote Control” function. 
2. Highlight the remote system you to establish a connection with. 
3. Click the “Connect” button on the toolbar or select the “Connect” command from the “Operation” menu. 
4. Enter the appropriate Login information in the popup window. 
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 Connect to a Remote System (Continued) 
 

 
 
Note: The initial user name/password for a remote system is RAID/hpt.  You are free to modify the 
username and password after the connection is established. 
If the connection is successful established, the application will retrieve the event logs from the remote 
system, then switch to Array Management view. 
 
Disconnect Remote System 
 
This function closes the connection from a connected system.  To disconnect a remote system: 
 
1. Highlight the “File” menu and select the “Remote Control” function. 
2. Highlight the system you want to disconnect from. 
3. Select the “Disconnect” command from the “Operation” menu. 
 
System Configuration 
 
This function is used to modify the service configuration on a remote system.  To change the service 
configuration: 
 
1. Highlight the “File” menu and select the “Remote Control” function. 
2. Highlight the remote system you want to modify. 
3. Select the “System Configuration” option from the “Operation” menu. 
4. Modify the information in the popup window. 
  

 
 
System Port - This is the TCP port number that the RAID Management Service uses to communicate with 
RAID Management Console.  When you connect to the service, the port value you enter must be in 
accordance with the system port value on the service.  The default value is 7402. 
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System Configuration (Continued) 
 
Event Port - The client software will retrieve events through this port.  The default value is 7403. 
The System Port value must differ from the value assigned to the Event Port.  After you reset a system’s 
configuration, you should restart the service on that system for the changes to take effect. 
 
5. Click “OK” to apply the changes. 
 
 
11 - Configuring Users and Privileges 
 
The RAID Management Console allows the Administrator to manage user accounts in its own database. 
You can setup multiple users and assign different privileges levels for the purpose of RAID management.  
Users can be assigned to each individual Remote System controlled by the RAID Management Console. 
 
Highlight the “File” menu and select the “User Management” function to configure User related options for 
the selected remote system. 
 

  
 
The user management window lists all users assigned to the selected remote system.  The current/active 
user will be designated with an icon. 
 
Add a User 
 
This function adds a user account to the connected remote system.  To add a user: 
 
1. Click the “Add” button in the User Management window. 
2. In the popup window, enter the user name, enter and confirm the password, and then click “Next”.  
  

 
 
3. Select the appropriate privileges for the user. 
4. Click “Finish”. 
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Delete a User 
 
This function deletes a user’s account on the connected remote system.  To delete a user: 
 
1. Select the target user ID from the User list displayed in the User Management window. 
2. Click Delete to remove the selected user. Click “Yes” to delete the item.  Select “No” to cancel this 
command. 
Note: An active user (user currently utilizing the software) cannot be deleted from the console. 
 
Set Password 
 
The Administrator uses this function to set a user’s password – the password allows a user to log on to a 
remote system, and utilize the RAID Management Console.  To set password for a user:  
 
1. Select the target user ID from the user list displayed in the User Management window. 
2. Click the “Set Password” option, and enter the password for the user. 
3. Click OK to apply your selections. 
 
Set Privilege 
 
The Administrator uses this function set a user’s privileges for the selected remote system.  To set 
privileges for a user: 
1. Select the target user ID from the user list displayed in the User Management window. 
2. Click the “Set Privilege” option. 
 

 
 
3. In the popup window, assign the privileges for the selected user. 
4. Click OK to apply your selections. 
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Linux Driver Support 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 



 

 35 

1 – Fedora Core 3 Linux installation Overview  
 
This section provides instructions describing how to install and utilize the RocketRAID 2220 Adapter on a 
Fedora Core 3 Linux system.   
 
 
2 - Installing Fedora Core 3 on the RocketRAID 2220 Host Adapter 
 
Note: If the OS is running kernel that differs from the one supported by the precompiled driver, the 
precompiled drivers cannot be used.  A driver can be built for this kernel using the OpenSource package for 
the RocketRAID 2220 controller.   This package is available from our website, and is posted on the 
BIOS/Driver page for the RocketRAID 2220. 
 
To install Fedora Linux onto hard disks or RAID arrays attached to RocketRAID 2220 controller, follow 
the steps outlined below: 
 
Step 1 Prepare the Driver Diskette  
 
The driver is contained in a floppy diskette image file. 
On a DOS or Windows system, a Fedora driver diskette can be generated using rawrite.exe.  This utility is 
included on the Fedora Linux CD (under /dosutils ).  Run rawrite.exe  using a command prompt window, 
and follow the directions it provides. 
On a Linux system, use the “dd” command to generate a boot diskette.  Insert a floppy disk into the floppy 
drive and type the following command:  
 
          # dd if=fc3-i386.img of=/dev/fd0    
 
Note: The driver disk image file depends on your core version and hardware. 
 
 
Step 2 Install Fedora Linux  
 
Installation steps for Fedora Core 3  
 
1) Boot from the Fedora Installation CD, and start the install procedure. 
 
2) At the "Welcome to Fedora Linux" installation screen, a prompt labeled "boot:" will appear at the 
bottom of the screen.  Type in  linux dd, then press Enter.  
 
 boot: linux dd  
 
3) When prompted “Do you have a driver disk?”, select “Yes”.  At the “Insert your driver disk and press 
OK to continue” prompt, insert the driver diskette in the floppy drive and then select "OK".  
 
4) The system will now load the RocketRAID 2220 driver automatically. 
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3 - Installing the RocketRAID 2220 driver for an Existing System  
 
Note: If a SCSI adapter is used to boot the system, make sure the RocketRAID 2220 controller BIOS 
loads/posts after the SCSI adapter’s BIOS.  It may be necessary to move the adapter(s) to another PCI slot. 
 
 
Step 1 Obtain the Driver Module  
 
Extract the module file from the file modules.cgz (from the driver disk) using the following commands:  
 
      # mount /dev/fd0  
      # cd /tmp  
      # gzip -dc /mnt/floppy/modules.cgz | cpio -idumv  
 
Driver modules for all supported kernel versions will be extracted. The driver module for the active kernel 
is located under the directory that matches the kernel version (/tmp/`uname –r`/i686/hptmv 6.ko). 
 
After extracting the driver module, load it using the following commands: 
 
 # modprobe sd_mod 
 # cd /tmp/`uname –r` 
 # insmod hptmv6.ko  
 
Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda). 
 
 
Step 2 Mounting and Partitioning the Device  
 
Example: A RAID array has been configured between several hard disks.  
 This array will be registered to the system as device “/dev/sda”.  
 

To create a partition on this array (which will listed as /dev/sda1), use the “fdisk /dev/sda” command. 
 

Next, use the “mkfs /dev/sda1” command to setup a file system on this partition.  
 

 Use the command “mkdir xxxx” to create a mount point for the RAID array.  Then mount /dev/sda1 
/xxxx in order to access it.   

 
Note: xxxx represents the desired name of the mount point. 

 
 
Step 3 Configure System to Automatically Load the Driver  
 
To avoid typing in "insmod hptmv6.ko" each time the operating system is booted, the system must be 
instructed to automatically load the module during bootup. To install the module, type in the following 
commands (first change to the directory where the proper hptmv6.ko file is located):  
 
   # cp hptmv 6.ko /lib/modules/`uname –r`/kernel/drivers/scsi.  
   # depmod  
 
Then, instruct the system to load the module when booting.  Use the following commands:  
 
  # echo “modprobe hptmv6” > /etc/init.d/hptdriver  
  # chmod 755 /etc/init.d/hptdriver  
 # ln –sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/S01hptdriver  
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  # ln –sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/S01hptdriver  
Step 3 Configure System to Automatically Load the Driver (continued) 
 

# ln –sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/S01hptdriver 
 
 
Step 4 Configure System to Mount Volumes during Startup 
 
The system can be instructed to automatically mount the array(s) during startup by modifying the 
file”/etc/fstab”. 
For example, add the following line to tell the system to mount /dev/sda1 to location /mnt/raid after startup:  
 

/dev/sda1       /mnt/raid           ext3    defaults   0 0  
 
 
4 - Updating the Driver  
 
1. If the original driver is installed in the system’s initrd (Initial RAM Disk) file (when using a system 

installed to Rocket RAID 2220 controller, for example), the driver module in t he initrd file should be 
updated using the mkinitrd command (or extract the initrd file and replace the driver module 
manually).  

 
2. If the original driver is installed in the /lib/modules/`uname –r`/kernel/drivers/scsi/ directory, and 

loaded by the script file (Example /etc/init.d/hptdriver) during the init process, or the configure file 
(Example /etc/modules.conf), please replace it with the new driver (hptmv 6.ko). 

 
 
5 - Uninstalling the Driver 
 
To uninstall the RocketRAID 2220 driver 
 
Note: The driver cannot be uninstalled while the system is booted from a disk or array attached to the 
RocketRAID 2220.   
 
To uninstall the driver, remove the lines added to /etc/fstab, and remove the files created in the /etc/init.d 
directory. 
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1 - Red Hat Enterprise 3 Overview  
 
This section provides instructions describing how to install and utilize the RocketRAID 2220 Adapter on a 
Red Hat Enterprise 3 Linux system.   
 
2 - Installing Red Hat Enterprise 3 (AS, ES, WS) Linux on the 
RocketRAID 2220 controller  
 
To install Red Hat Enterprise Linux onto disks or RAID arrays attached to RocketRAID 2220: 
 
Step 1 Prepare the Driver Diskette 
 
The driver is provided in a floppy diskette image file format.   
On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.  This utility is included 
on the Red Hat Enterprise Linux CD (under /dosutils ).  Run rawrite using a command prompt window, and 
follow the directions it provides. 
On a Linux system, use the “dd” command to generate a boot diskette.  Insert a floppy disk into the floppy 
drive and type the following command (amd64 driver for example): 
 

# dd if=rh3dd-amd64.img of=/dev/fd0 
 
 
Step 2 Install Red Hat Enterprise Linux  
 
1. Start installing Red Hat Enterprise Linux by booting from the installation CD.  
 
2. At the "Welcome to Red Hat Linux" installation screen, a prompt labeled "boot:" will appear at the 

bottom of the screen.  Type in linux dd, then press Enter.  
 

boot: linux dd 
 
3. When prompted “Do you have a driver disk?”. Select “Yes”.  
 
4. When prompted “Insert your driver disk and press OK to continue”, insert the driver diskette into the 

system’s floppy drive, and select "OK".  
 
5. The system will now load the RocketRAID  2220  driver automatically. 
 
6. When prompted “Where do you want to install the boot loader? ” in the “Boot Loader Configuration” 

dialog, select “Master Boot Record (MBR)” to instruct the system be to boot from the RocketRAID 
2220. 

 
Continue the installation as normal. You can refer to Red Hat Enterprise Linux installation guide.   
 
 
Note: 
1. The system device mapping order is the same as the order shown in RocketRAID 2220 BIOS   
Setting Utility.  If no other SCSI adapters are installed, the device marked as   
“BOOT” or “HDD0”will identified as /dev/sda , “HDD1” as /dev/sdb, “HDD2” as   
/dev/sdc, etc.  When creating mount points, /boot must be mounted on /dev/sda . 
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3 - Installing the RocketRAID 2220 driver for an Existing System  
 
Note: If a SCSI adapter is used to boot the system, make sure the RocketRAID 2220 controller BIOS 
loads/posts after the SCSI adapter’s BIOS.  It may be necessary to move the adapter(s) to another PCI slot. 
 
Step 1 Obtain the Driver Module  
 
Extract the module file from the file modules.cgz (from the driver disk) using the following commands:  
 

# mount /dev/fd0  
# cd /tmp  
# gzip -dc /mnt/floppy/modules.cgz | cpio -idumv  

 
Driver modules for all supported kernel versions will be extracted. The driver module for the active kernel 
is located under the directory that matches the kernel version (/tmp/`uname –r`/hptmv 6.o). 
 
After you have e xtracted the driver module, you can load it by following commands: 
 
 # modprobe sd_mod 
 # cd /tmp/`uname –r` 

# insmod hptmv6.o 
 
Arrays attached to the adapter can be accessed as SCSI devices (e.g. /dev/sda). 
 
Step 2 Mounting and Partitioning the Device  
 
Example: A RAID array has been configured between several hard disks.  
 This array will be registered to the system as device “/dev/sda”.  
 

To create a partition on this array (which will listed as /dev/sda1), use the “fdisk /dev/sda” command. 
 

Next, use the “mkfs /dev/sda1” command to setup a file system on this partition.  
 

 Use the command “mkdir xxxx” to create a mount point for the RAID array.  Then,mount /dev/sda1 
/xxxx in order to access it.   

 
Note: xxxx represents the desired name of the mount point . 
 
 
Step 3 Configure System to Automatically Load the Driver  
 
To avoid typing in "insmod hptmv6.o" each time the operating system is booted, the system must be 
instructed to automatically load the module during bootup. To install the module, type in the following 
commands (first change to the directory where the proper hptmv6.o file is located):  
 
  # install -d /lib/modules/`uname –r`/kernel/drivers/scsi  

# install -c hptmv 6.o /lib/modules/`uname –r`/kernel/drivers/scsi 
 
Then, instruct the system to load the module when booting.  Use the following commands:  
 
  # echo “modprobe hptmv6” > /etc/init.d/hptdriver  
  # chmod 755 /etc/init.d/hptdriver  
  # ln –sf /etc/init.d/hptdriver /etc/rc.d/rc3.d/S01hptdriver  
  # ln –sf /etc/init.d/hptdriver /etc/rc.d/rc4.d/S01hptdriver  

# ln –sf /etc/init.d/hptdriver /etc/rc.d/rc5.d/S01hptdriver 
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Step 4 Configure System to Mount Volumes during Startup 
 
The system can be instructed to automatically mount the array(s) during startup by modifying the 
file”/etc/fstab”. 
For example, add the following line to tell the system to mount /dev/sda1 to location /mnt/raid after startup:  
 

/dev/sda1       /mnt/raid           ext2    defaults   0 0  
 
 
4 - Updating the Driver 
 
If you are not booting from disks attached to RocketRAID 2220 controller, you can update the driver just 
by reinstalling it following the procedure outlined in the previous section, "Installing the RocketRAID 2220 
driver for an Existing System".  
 
If you are running the system installed to a disk or array attached to the RocketRAID 2220: 
 

First, obtain the new driver module “hptmv 6.o”. Refer to the previous section “Obtain the Driver 
Module”.  In following steps, we assume it has been copied to “/tmp/hptmv 6.o”.  

 
Replace hptmv 6.o in the boot RAM disk image, /boot/initrd-xxx.img (where xxx is the kernel version). 

 
Example: (2.4.21-4.EL for Red Hat Enterprise Linux 3.0): 

 
# gzip -dc /boot/initrd-xxx.img > /tmp/initrd.ext2 
# mkdir /mnt/initrd # mount -o loop /tmp/initrd.ext2 /mnt/initrd  
# cp /tmp/hptmv6.o /mnt/initrd/lib/hptmv 6.o # umount /mnt/initrd  
# gzip -c /tmp/initrd.ext2 > /boot/initrd-xxx.img  

 
If you are using lilo to boot the system, use "lilo" to reinstall the RAM disk:  

 
# lilo  

 
Update hptmv 6.o in /lib/modules: 
  
   # cp /tmp/hptmv 6.o /lib/modules/`uname –r`/kernel/drivers/scsi/hptmv 6.o 
 
Reboot your system to allow the new driver take effect.  

 
 
5 - Uninstalling the Driver 
 
To uninstall the RocketRAID 2220 driver 
 
Note: The driver cannot be uninstalled while the system is booted from a disk or array attached to the 
RocketRAID 2220.   
 
To uninstall the driver, remove the lines added to /etc/fstab, and remove the files created in the /etc/init.d 
directory. 
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1 – SuSE Linux Enterprise Server (SLES) installation Overview  
 
This section provides instructions describing how to install and utilize the RocketRAID 2220 Adapter on a 
SuSE (SLES) Linux system.   
 
 

2 - Installing SLES Linux on the RocketRAID 2220 Host Adapter 
 
Note: If the OS is running kernel that differs from the one supported by the precompiled driver, the 
precompiled drivers cannot be used.  A driver can be built for this kernel using the OpenSource package for 
the RocketRAID 2220 controller.   This package is available from our website, and is posted on the 
BIOS/Driver page for the RocketRAID 2220. 
 
To install SLES onto hard disks or RAID arrays attached to RocketRAID 2220 controller, follow the steps 
outlined below: 
 
Step 1 Prepare the Driver Diskette 
 
The driver is contained in a floppy diskette image file (slesdd.img). 
On a DOS or Windows system, a driver diskette can be generated using rawrite.exe.  This utility is included 
on the SLES Linux CD (under /dosutils).  Run rawrite using a command prompt window, and follow the 
directions it provides. 
On a Linux system, use the “dd” command to generate a boot diskette.  Insert a floppy disk into the floppy 
drive and type the following command:  
 
           # dd if=SLESdd.img of=/dev/fd0  
 
Step 2 Install SLES Linux  
 
1. Start the install procedure by booting from SLES installation CD.  
 
2. After the CD boots, select the "Installation" option and press F6 to load the driver.  
 
3. Insert the Driver Diskette when it displays "Please insert the Driver Update floppy".  
 
4. When the “Diver Update Menu” is displayed, press "OK" and "back" for back to installer.  
 
5. Next. Select “back” to return to the installer. 
 
6. Installation will now proceed normally. Refer to SLES Linux documents for additional OS installation 

procedures. 
 
Additional Installation Notes: 
 
The system device mapping order is the same as the order shown in RocketRAID 2220 BIOS Setting 
Utility.  If no other SCSI adapters are installed, the device marked as “BOOT” or “HDD0” will be 
identified as  /dev/sda, “HDD1” as /dev/sdb, “HDD2” as /dev/sdc , etc.  When creating mount points, /boot 
must be mounted on /dev/sda.   
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3 - Installing the RocketRAID 2220 Driver on an Existing System  
 
If you are currently running SLES and would like to access drives or arrays attached to the Rocket RAID 
2220 controller, follow the steps outlined below: 
 
Note:  
If a SCSI adapter is used to boot the system, make sure the RocketRAID 2220 controller BIOS loads/posts 
after the SCSI adapter’s BIOS.  It may be necessary to move the adapter(s) to another PCI slot. 

 

 
Step 1 Update Grub 
 
If you are running an SLES 9 SMP System, you must first update the /boot/grub/menu.lst. 
  
Example:  
default=0  
timeout=8  
title Linux   
kernel (hd0,1)/vmlinux root=/dev/hda1 acpi=off  
initrd (hd0,1)/initrd   
 
Reboot the system to allow the new kernel parameters to take effect.  
 

 
Step 2 Install the Driver Module  
 
Extract the module file from the file /linux/suse /[arch]-[version]/install/update.tar.gz (from the driver disk), 
using the following commands:  
 

 # mount /dev/fd0 /media/floppy  
# cd /  
# tar xfz /media/floppy/linux/suse/i386-sles9/install/update.tar.gz 

 
The driver modules will be extracted to the directory /lib/modules/[kernel-ver]/kernel/drivers/scsi/ . 
 
After you have extracted the driver module, you can load it by following commands: 
 
 # modprobe sd_mod 
 # insmod /lib/modules/`uname –r`/kernel/drivers/scsi/hptmv6.ko 
 
Then you can access the arrays attached to the controller as SCSI devices (e.g. /dev/sda). 
 
 
Step 3 Mounting and Partitioning the Device  
 
Note: Many versions of SuSE include YAST.  YAST is a graphical configuration utility that is capable of 
executing the commands described below.  We recommend using YAST, if available, as it may help 
simplify the installation process. 
 
Example: A RAID array has been configured between several hard disks.  
 This array will be registered to the system as device “/dev/sda”.  
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1. To create a partition on this array (which will listed as /dev/sda1), use the “fdisk /dev/sda” 
command. 

 
2. Next, use the “mkfs /dev/sda1” command to setup a file system on this partition.  

 
3. Use the command “mkdir xxxx” to create a mount point for the RAID array.  Then, mount 

/dev/sda1 /xxxx in order to access it.  
 

Note: xxxx represents the desired name of the mount point. 
 
 
Step 4 Configure System to Automatically Load the Driver  
 
To avoid typing in "insmod hptmv6.o" each time the operating system is booted, the system must be 
instructed to automatically load the module during bootup. To install the module, type in the following 
commands (first change to the directory where the proper hptmv6.ko file is located): 
 

1. Edit the file “/etc/sysconfig/kernel”, and add the hptmv6 module to the line 
“INITRD_MODULES=…” 

 
Example:   

 
INITRD_MODULES=”reiserfs hptmv 6”  

 
2. Run the “depmod” command to update the module configuration:  
 

# depmod  
 

3. Next, run the “mkinitrd” command to update the initrd file: 
 

# mkinitrd  
 

4. If you are using the lilo boot loader, run lilo again:  
 

# lilo  
 
 
Step 5 Configure System to Mount Volumes during Startup 
 
The system can be instructed to automatically mount the array(s) during startup by modifying the 
file”/etc/fstab”. 
For example, add the following line to tell the system to mount /dev/sda1 to location /mnt/raid after startup:  
 

/dev/sda1       /mnt/raid           ext2    defaults   0 0  
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4 – Updating the Driver 
 
To update the driver, simply reinstall the driver following the steps in previous section, " Install 
RocketRAID 2220 Driver on an Existing System ".  
 
Note: If the driver is loaded in initrd (when system is installed onto a disk or array attached to the 
RocketRAID 2220), you need to run the mkinitrd command to update the initrd file. If you are using the 
lilo boot loader, run lilo again (# lilo). 
 
 
 
5 - Uninstalling the Driver 
 
To uninstall the RocketRAID 2220 driver 
 
Note: The driver cannot be uninstalled while the system is booted from a disk or array attached to the 
RocketRAID 2220.   
 
To uninstall the driver, remove the lines added to /etc/modules.conf and /etc/fstab. 
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Customer Support 
 
If you encounter any problems while utilizing the RocketRAID 2220, or have any questions about this or 
any other HighPoint product, feel free to contact our Customer Support Department. 
 
 
Troubleshooting Checklist 
 
Before contacting our Customer Support department: 
 
Make sure the latest BIOS, driver and RAID Software have been installed for the RocketRAID 2220.  
Updates are available from our website. 
 
Prepare a list of the computer system’s hardware and software (motherboard, CPU, memory, other PCI 
devices/host adapters, operating system, applications) 
  
 
Contact Information 
 
E-mail address: support@highpoint-tech.com 
 
Phone: 510-623-0968 (request for support) 
9:00AM-5:00PM, Pacific Standard Time 
 
Additional information about HighPoint products is available from our web site:  
 
http://www.highpoint-tech.com 
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FCC Part 15 Class B Radio Frequency Interference  statement 
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to part 15 of the FCC Rules.  These limits are designed to provide 
reasonable protection against harmful interference in a residential installation.  This 
equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio 
communications.  However, there is no guarantee that interference will not occur in a 
particular installation.  If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the following 
measures: 
l Reorient or relocate the receiving antenna.   
l Increase the separation between the equipment and receiver.   
l Connect the equipment into an outlet on a circuit different from that to which the 

receiver is connected.   
l Consult the dealer or an experienced radio/TV technician for help.   
Modifications not expressly approved by the manufacturer could void the user’s authority 
to operate the equipment under FCC rules.   
 
This device complies with part 15 of the FCC Rules.  Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and (2) this 
device must accept any interference received, including interference that may cause 
undesired operation.   
 

European Union Compliance Statement 
This Information Technologies Equipment has been tested and found to comply 
with the following European directives: 
l European Standard EN55022 (1998) Class B 
l European Standard EN55024 (1998) 
 
  
 
 
 
 
 

 
 
 


